
Module  1   Computing Fundamentals 

CRITICALThinking

ACTIVITY 3-1

Beyond aesthetics, is there a practical use for applying a desktop background? Include a brief
explanation in your answer. If your answer is yes, include an example of a practical application.
If your answer is no, cite an example of how a desktop background might impair productivity.
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The utility program Windows Explorer is designed to help you find, view, and manage files
easily and effectively. Explorer gives you control over the organization and management of your
files and folders. Like My Computer, which you used in earlier lessons, Explorer makes it easy to
view the contents of selected disks and folders. In earlier versions of Windows, My Computer
and Windows Explorer were separate programs. In Windows XP, My Computer and Windows
Explorer are actually the same program; you simply click the Folders button on the toolbar in
My Computer to access the Windows Explorer features. All the disk and folder maintenance
operations you use with My Computer are available in Windows Explorer. Explorer simply pro-
vides additional features to make the tasks easier and faster. In this lesson, you will learn how to
use options in Windows Explorer to control the display of files and folders.

LESSON 4

USING WINDOWS EXPLORER

OBJECTIVES
Upon completion of this lesson, you should be able to:

n Define uses for Windows Explorer.

n Identify the parts of the Explorer window and the
icons used to represent drives, disks, files, and
 folders.

n Use Explorer to view the contents of a drive or folder. 

n Expand and collapse the folder list. 

n Change the view in the Explorer contents pane. 

n Sort the information in the contents pane by criteria
in the Details view.

n Display information about a file or folder in the
Properties dialog box.

n Search for files or folders.

Estimated Time: 1.5 hour

VOCABULARY

Contents pane

Folders bar

Search

Sorting

Tree pane

Wildcard characters

Windows Explorer
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The Explorer Window
Windows Explorer gives you the capability to search for files and folders, to find details

about the contents of the files and folders, and to manage them—deleting, copying, and moving
files and folders as necessary. There are three ways to start Explorer:

n Click Start, point to All Programs, point to Accessories, and then click Windows Explorer. 

n Right-click over the Start button, and then select Explore from the shortcut menu.

n Click Start, click My Computer, and then click the Folders button on the toolbar.

The right pane of the Explorer window looks similar to and functions like the My Computer
window. The major difference between the My Computer window and the Windows Explorer
window is how the left pane is used. As you can see in Figure 4-1, My Computer’s left pane con-
tains a resource bar that provides links to system tasks and your computer’s resources.

FIGURE 4-1
My Computer window

Explorer’s left pane (see Figure 4-2) contains the Folders bar, which lets you see the structure
of your folders at a glance and allows you to move and copy files by dragging them from one
pane to the other. If you’ve worked in previous versions of Windows, this pane should look
familiar to you.

Links to tasks
and resources

1-3.2.6
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Lesson  4 Using Windows Explorer

FIGURE 4-2
Windows Explorer window

Note that with either of these windows, because they are really working from the same pro-
gram, you can alter your view to appear like the other. For example, if you are in the My
Computer window and you click the Folders button on the toolbar, the links will disappear and
will be replaced by the Folders bar. If you are in the Windows Explorer window and you click on
the Close button at the top right of the Folders panel, the Folders bar will disappear and be
replaced by the links to System Tasks and Other Places.

S TEP-BY-STEP 4.1
1. Start your computer and launch Windows XP if  necessary.

2. Click Start, point to All Programs, point to Accessories, and then click Windows
Explorer. If Windows Explorer does not appear on the Accessories menu, click the
down arrow at the bottom of the menu. Leave this window open for the next Step-by-Step. 

Identifying the Parts of the Explorer Window
By now, you should recognize the window features

common to many Windows XP screens. If you are new
to Windows XP, however, you may not know the func-
tion of the two panes in the Explorer window. The
Folders bar (left pane) is commonly referred to as the
tree pane. The right pane is called the contents pane.
These panes are discussed below.

Folders Bar (Tree Pane)
The Folders bar is also called the tree pane because

its hierarchical display of all objects on the desktop is like a tree’s trunk and branch system. But in
this case, the tree is upside down: Its main root (Desktop) is at the top, with folders and subfolders
branching off below it.

Computer Concepts
Windows XP continually moni-
tors the programs you use. The
programs and files that have not
been accessed in some time
will not be displayed on a menu
until you click the down arrows
at the bottom of the menu. The
menu listing will expand to show
all the options on the menu.

Currently
selected drive
or folder

Contents pane
showing contents
of C drive
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Contents Pane
The display shown in the right pane (the contents pane) changes depending on the folder,

disk, or other object selected in the left pane. In other words, the two panes—tree and contents—
work together. For example, note in Figure 4-2 that Local Disk (C:) is selected. Also note that the
Address Bar says C:\, thus matching the object selected in the left pane. If the WINNT folder is
selected in the tree pane, the listing in the contents pane changes to show what’s in the WINNT
folder and the Address Bar reads C:\WINNT. Explorer’s title bar also displays the name of the
disk or folder you’re currently exploring in the contents pane. 

Identifying the Icons in the Explorer Window
At the top of the tree pane is the Desktop icon. You may have to scroll to bring it into view.

This icon represents the Windows desktop, and all icons are shown in the tree pane as stemming
from the Desktop icon. Look at Figure 4-3. Note how the My Documents, My Computer, and
My Network Places icons appear below and to the right of the Desktop icon. The placement of
these icons makes it clear that these folders are subordinate to—or down one level from—the
Desktop. The graphic used for each icon gives you a clue about what is represented—a drive, a
folder, or an application file, for example.

FIGURE 4-3
Icons in the Explorer window

Each of these icons, in turn, has icons below and to the right of them. Under the My
Computer icon, for example, you may see an icon for a floppy drive or a CD/DVD drive and an
icon for the hard drive. The hard drive icon has a number of folders displayed below and to the
right of it. These are the applications and other folders stored on the drive.

Finally, Explorer shows you whether each of these folders has subfolders within it. Notice in
Figure 4-3 the small boxes to the left of some icons. Boxes containing a plus sign (+) indicate
folders that have subfolders not currently displayed. If a box contains a minus sign (–), the

Top-level folder

Subordinate
folders
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Lesson  4 Using Windows Explorer

 subfolders are displayed below the folder. In Figure 4-3,
for example, the minus sign next to the My Computer
icon indicates that all subfolders in that folder are dis-
played below. The plus sign next to the Shared
Documents folder indicates that this folder contains
subfolders that are not displayed. (See the Expanding
and Collapsing the Tree section, which follows.)

As you can see from a careful look at the tree pane,
Explorer uses one view to show the same information
that would require several views in My Computer. You’ll find this view makes it very easy to han-
dle file-management tasks.

The contents pane also shows several types of icons, depending on the object selected in the
tree pane. Look at Figure 4-4. This figure shows that the WINNT folder has been selected. The
label WINNT is highlighted in the tree pane, and the folder icon appears to be open. The con-
tents pane shows the contents of this folder, which include both subfolders (identified by the yel-
low folder icons) and files (identified by icons other than that of a folder). 

FIGURE 4-4
Displaying the contents of a folder

You can see the subfolders in the contents pane even when they are not displayed in the tree
pane. Being able to control each pane independently of the other gives you great flexibility when
you are copying, moving, viewing, or otherwise manipulating files.

Expanding and Collapsing the Tree
When you open Explorer, it does not display subfolders. If you want to display subfolders for

any folder, you must expand the folder list (increase the subfolder display level). To expand the
folder list, just click the plus sign in the box to the left of the folder. As the subfolders appear
below the folder, the plus sign changes to a minus sign. When you click the minus sign, you col-
lapse the folder list (decrease the subfolder display level).

Collapsing a folder makes it possible to view more objects in the tree. This is useful if you are
trying to copy or move files between different folders. Collapsing folders also makes the folder
list less cluttered, so it is easier to locate files and folders.

Note
If you are displaying the con-
tents of a folder for the first
time, you may have to click the
Show Files or Show the con-
tents of this folder link in the
contents pane first.

Open folder

Contents of
open folder
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S TEP-BY-STEP 4.2
1. Click the My Computer icon in the tree pane.

2. Find the drive on which the WINNT or WINDOWS folder
is stored (generally drive C). If the box to the left of
the drive has a plus sign, click the plus sign (+). 

3. Locate the WINNT or WINDOWS folder, and note
whether there is a plus or a minus sign in the box to
the left of the icon.

4. Click the box to the left of the WINNT or WINDOWS
folder icon. If the box has a plus sign, the tree will
expand, showing the subfolders below the folder; if
the box displays a minus sign, the tree will  collapse.

5. If necessary, click again on the box to the left of the folder icon to display the subfolders in the
tree pane.

6. Notice that a number of the subfolders have additional subfolders, as indicated by a plus sign in the
box to the left of the subfolder.

7. Expand the system32 folder (you may have to use the tree pane’s scroll bar to find it), and display all
of its subfolders and their subfolders:
a. Click the plus sign in front of the system32 folder.
b. Click the plus sign in front of the drivers folder.

8. Click the minus sign (–) in front of the drivers folder. Notice that the drivers folder list collapses.

9. Click the minus sign in front of the system32 folder and the minus sign in front of the WINNT or
 WINDOWS folder. Remain in this screen for the next Step-by-Step.

Setting Explorer Options
Explorer’s View menu is similar to all View menus in other program windows. You can

choose to display the Standard toolbar buttons and the status bar, for example, and you can
change the view of the contents pane to Thumbnails, Tiles, Icons, List, or Details.

Views
The default view for Windows Explorer displays tiles (large icons) in the right pane, as shown

in Figure 4-5. Depending on the task and your goal, you can choose the view option to best meet
your objectives.

Note
On your system, the WINNT
folder may have a different
name. It may, for instance, be
called WINDOWS or Windows. If
you are uncertain, ask your
instructor for assistance. In this
and subsequent Step-by-Step
instructions, substitute the
appropriate name of your
folder wherever you see the
name WINNT.

1-3.2.6
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FIGURE 4-5
Windows Explorer—Tiles view

n Thumbnails: Displays the images a folder contains on a folder icon so you can identify the
contents of the folder quickly. For example, in Thumbnails view, you can see small images
of pictures stored within a folder on the folder. By default, four images will be displayed on
the folder, and the folder name is displayed under the folder icon. 

n Tiles: Displays a large icon and filename for each file and provides a visual clue to the type
of file and the file contents, such as a musical note for music files or a picture for image
files. Information about the file, such as the date it was last modified or the type of file, is
displayed below the icons.

n Icons: Displays small icons with filenames
below them, generally arranged horizontally
across the screen.

n List: Provides a list of all files and folders. Displays
small icons and the filename, usually in a vertical
arrangement.

n Details: With details, you get much more informa-
tion than you do with the other view types.
Details view can show the file icon, the filename,
the file size, the associated application, the date
and time the file was created or last modified,
and other information depending on the chosen options.

Additionally, if a folder contains all graphic files, the Filmstrip view becomes an option as
well. With the Filmstrip view, you see a larger image than you do with the Thumbnail view and
you can scroll through all the files in the folder.

Note
To change the information listed
in Details view, click the View
menu and then click Choose
Details. Click in the box to
the left of each detail name to
select it; if you want to elimi-
nate a selected detail, click
the box to deselect it. Then
click the OK button to apply
the new details.
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S TEP-BY-STEP 4.3
1. On the View menu, click Thumbnails. The display now shows large icons representing folders and

files, with images on the folders that indicate their contents. 

2. On the View menu, click Icons. The display now shows a horizontal arrangement of folders and files
represented by icons and titles.

3. On the View menu, click List. The display now shows a vertical arrangement of folders and files rep-
resented by icons and titles. 

4. On the View menu, click Details. The display now shows a detailed list of each folder, and may include
information such as name, size, type, and date and time created or last modified (Figure 4-6). Leave
this window open for the next Step-by-Step.

FIGURE 4-6
Windows Explorer—Details view

Sorting
To help you more easily locate files and folders, you can also sort the items displayed in a

window. Sorting is the process of creating a list organized on a specific criterion. For example,
you can sort a list of files in alphabetical order by filename, by size from smallest to largest, or by
date created or modified, from most recent to oldest files. If you are looking for a file, but you
can’t remember the name, you might remember that you worked with the file within the last few
days. Your best option is to sort by date modified, as shown in Figure 4-7. You can sort files by
any details listed in Details view, such as name, size, and type. To sort by any option, just click
the column name in Details view.
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FIGURE 4-7
Windows Explorer—files sorted by date modified

The Toolbar
Explorer’s toolbar is similar to the My Computer

toolbar. You will see the Back, Forward, and Up navi-
gation buttons that help you navigate in both the tree
pane and the contents pane. The Views button at the far
right of the toolbar lets you change the way objects are
displayed in the contents pane only. The options from
the Views button are the same as those listed above:
Thumbnails, Tiles, Icons, List, Details, and Filmstrip
(for folders containing only graphic files). The Search
button opens the Search Companion to help you find specific files or folders, which you will
learn about later in this lesson.

Remember you can change the Standard toolbar in any window, including the Explorer win-
dow, by clicking the Toolbars option from the View menu and then selecting the Customize
option from the submenu. In the Customize dialog box, you can add or remove buttons from the
toolbar. You can also change how information about toolbar buttons is displayed. In the Text
options drop-down list, you can choose to display text identification for each button or to have
identifying text appear when you rest the mouse pointer on the button. You can also choose the
No text labels option, but you will probably find that the labels help you learn about the avail-
able toolbar commands. 

Computer Concepts
The arrow that appears next to
the column head in Details view
indicates whether the list is
sorted in ascending order (arrow
points up) or descending order
(arrow points down).
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Viewing the Contents of a Drive or Folder
Most folder and file operations require you first to identify the drive you want to use. In

Explorer, icons in the tree pane represent the available disk drives, folders, and other objects. To
select a drive, for example, click the appropriate drive icon. The drive is highlighted in the tree
pane, and its contents appear in the contents pane (see Figure 4-8).

FIGURE 4-8
Highlighting shows which disk drive is selected

You can also select a drive or another desktop
object (such as the Recycle Bin) by clicking the object in
the Address Bar drop-down list. This action moves you
directly to the object in the tree pane. If you have a very
large tree displayed, it may be easier to select an object
this way than to scroll in search of it.

To view the contents of a folder, click the folder in the
tree pane. The folder opens and its contents appear in the
contents pane. If the folder has subfolders, you can dou-
ble-click a subfolder in the contents pane. When you do
so, the subfolder’s contents are displayed in the contents
pane and the tree pane expands to show any subfolders.

S TEP-BY-STEP 4.4
1. Click the icon of the drive where your Assignments folder is located. The contents pane shows the

contents of the disk or drive.

2. Double-click the Assignments folder in the contents pane. Notice that the folder’s contents now
appear in the contents pane and that the tree pane shows the open folder under the drive icon. 

3. Click the WINNT or WINDOWS folder (usually found on drive C) in the tree pane to display the
 contents of the folder on your hard drive.

Note
If the Address Bar is not visible
in your Windows Explorer
screen, click on the View menu
and then open the Toolbars sub-
menu. A check mark appears
next to selected toolbars.
Select Address Bar if it is not
selected.

Selected
drive

Contents of
C drive

1-3.2.6
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STEP-BY-STEP 4.4 Continued

4. In the contents pane, double-click the system folder. (If necessary, click Show Files or Show the
 contents of this folder in the contents pane.) 

5. Click the View button on the toolbar and select List. Your display should resemble Figure 4-9.

FIGURE 4-9
Contents of the system folder

6. Click the Up button on the toolbar to select the WINNT or WINDOWS folder again. 

7. From the Address Bar drop-down list, select the drive that contains your Assignments folder. (If
the Address Bar is not visible, select it from the Toolbars submenu on the Views menu.)

8. Click the Close button to close Windows Explorer. 

Displaying File Properties 
The Properties dialog box for a file or folder in Windows displays information about the file

or folder, including the type of file, the name of the program that opens the file, the file size, the
file location, and the date the file was created and last modified. To display the properties for a

1-3.2.6
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file or folder in Windows, right-click the filename or folder in Windows Explorer, and then click
Properties. Figure 4-10 shows the properties for a Microsoft Word file named Letter.doc. 

FIGURE 4-10
Properties dialog box in Windows

Files created in different programs can have addi-
tional properties that are displayed in the Properties
dialog box within that program. For example, in addi-
tion to General properties, a Microsoft Word document
can have Summary, Statistics, Contents, and Custom
properties, which might include the document’s author,
the number of words and paragraphs in the document,
and the name of the client for whom the document was
created. Figure 4-11 shows the Summary tab of the
Properties dialog box in Word for the file Letter.doc. 

FIGURE 4-11 
Summary tab in the Properties dialog box in Microsoft Word

Note
You can also open the
Properties dialog box by right-
clicking any icon on the
Windows desktop. This will open
the shortcut menu so you can
select Properties to open the
dialog box.
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S TEP-BY-STEP 4.5
1. Open Windows Explorer. To do this, right-click the Start button, and then click

Explore. 

2. Click the My Documents icon in the tree pane and look for a data file, such as a word-processing file,
an image (or picture) file, or an audio file. Your instructor may direct you to a specific folder to find a data
file, or you can open the My Pictures folder and find an image file in the Sample Pictures subfolder.

3. Right-click the file icon in the contents pane.

4. Click Properties. Notice which properties are displayed on the General tab in the dialog box.

5. If there are other tabs in the Properties dialog box, click on each tab and look at the information
 displayed. Close the Properties dialog box.

6. Close Windows Explorer.

Finding Files and Folders
The Windows XP Search feature allows you to find files and folders by specifying a variety

of search criteria. For example, you can search for files and folders by name, by date, by type, by
size, or by a string of text that they contain. There are three ways to access the Search feature:

n In Windows Explorer, click the Search button on the toolbar. 

n If you are not in the Explorer window, click the Start button and then click Search on the
Start menu. 

n Right-click over the Start button and then select Search… from the shortcut menu.

LOGICAL SEARCH TOOLS

In the 1840s, George Boole, a self-educated mathematician from England, developed
ways of expressing logical processes using algebraic symbols. The Boolean logic uses
words called operators to determine whether a statement is true or false. This Boolean
logic has become the basis for computer database searches. The most common opera-
tors used are AND, OR, and NOT. These three simple words can be extremely helpful
when searching for data. For example, if you search for “railroad AND models,” the
results will include documents with both words. If you search for “railroad OR models,”
the results will include the greatest amount of matches listing documents with either
word. A good way to limit the search is to search for “railroad NOT models.” The results
will then include all documents about railroads but not documents about models.

TECHNOLOGY TIMELINE

1-3.2.6
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The Search or Search Results window will open. The left pane is called the Search
Companion and offers a list of options to search. Figure 4-12 shows the Search window that
opens in the left pane when you click the All files and folders option.

FIGURE 4-12
Search Results window

In the All or part of the file name text box, type all or part of the name of the file you want to
find. You can also use the wildcard characters (* or ?) to substitute for characters in a filename.
Use * to substitute for zero or more characters and use ? to substitute for only one character. 

To search for files containing specific text, type the text you want to find in the A word or
phrase in the file text box. Use the Look in list arrow to select the drive or folder you want to
search. To specify additional search criteria, click on the down arrow button next to one of the
available search options, and then select one or more of the options to narrow your search.
Table 4-1 describes the search options available. When you are finished selecting search options,
click the Search button at the bottom of the Search Companion pane to start your search.

TABLE 4-1
Search options

SEARCH OPTION USE TO
When was it modified? Find files that were created or modified on or between

specific dates

What size is it? Find files of a specific size

Type of file Find files of a specific type, such as a Microsoft Word document

Search system folders Search in the folders that contain system information

Search hidden files and folders Search in files or folders that have the hidden attribute

Search subfolders Search all the subfolders in a drive or folder
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S TEP-BY-STEP 4.6
1. Click the Start button on the taskbar and then click Search in the Start menu.

2. Click the All files and folders option in the Search Companion (left) pane.

3. Key the name of a file from My Documents for which you would like to search in the All or part of the
file name text box.

4. Choose My Documents from the drop-down menu of the Look in field if it is not already selected.

5. Click the down arrow button next to More advanced options. Make sure that Search subfolders is
checked.

6. Click the Search button.

7. Select the file you want from the list of files and folders in the right pane. Double-click on the file to
open it.

8. Close the file.

9. Close the Search window.

SUMMARY

In this lesson, you learned:

n Windows Explorer and My Computer are actually the same program in Windows XP. 

n When you start Explorer, you see a window with the familiar title bar, menu bar, display
window, and status bar. The display window is divided vertically into two panes—a left
pane, which displays the Folders bar, and a right pane, which displays the contents.

n The Folders bar, also referred to as the tree pane, displays all the objects on the desktop in a
hierarchical structure, and it displays the folder structure for the currently selected disk. The
contents pane displays the contents of the folder selected in the tree pane.

n In the tree pane, the open folder is the active folder. In the contents pane, a folder icon rep-
resents a subfolder of the open folder.

TABLE 4-1 Continued
Search options

SEARCH OPTION USE TO
Case sensitive Find files with upper- and lowercase letters that match the

filename search criteria 

Search slow files or Search Find files stored on removable storage devices, such as a tape 
tape backup backup device

Lesson  4 Using Windows Explorer
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n Explorer’s View menu options and Views button allow you to control how files are dis-
played in the contents pane. You can select Thumbnails, Tiles, Icons, List, Details, and
sometimes Filmstrip (for graphics files).

n Sorting files in the contents pane organizes the list according to a specific criterion. You can
sort files and folders by many specifications including name, size, date modified, and type.

n In the tree pane, you can collapse (decrease the levels shown in) the tree so the folders and
subfolders do not appear. You can also expand (increase the levels shown in) the tree so it
shows folders of all levels. 

n You can display the properties of a file by right-clicking the filename in the Explorer window
and then selecting Properties from the shortcut menu to open the Properties dialog box,
which provides information about the file including size, type, date, author, and other details. 

n The Search feature is available in Windows Explorer by clicking on the Search button on
the toolbar, or you can access Search directly from the Start menu. 

n Options in the Search Companion allow you to refine your search to find specific files or
folders.

VOCABULARYReview

REVIEWQuestions

TRUE/FALSE

Circle T if the statement is true or F if the statement is false.

T F 1. To start Windows Explorer, you select All Programs on the Start menu and then
select Windows Explorer.

T F 2. In Windows Explorer, the Folders bar is also called the contents pane.

T F 3. When viewing files as Thumbnails, you can see the date and time the file was
 modified.

T F 4. To find a specific file, use the Windows Search feature.

T F 5. A plus sign next to a folder in Explorer’s tree pane indicates folders that have sub-
folders not currently displayed.

Define the following terms:
Contents pane
Folders bar
Search

Sorting
Tree pane

Wildcard characters
Windows Explorer
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MULTIPLE CHOICE

Circle the best response for each of the following statements.

1. Windows Explorer and are the same program in Windows XP.
A. Desktop
B. WordPad
C. My Computer
D. Recycle Bin

2. creates a list organized on a specific criterion.
A. Searching
B. Sorting
C. Exploring
D. Tiling

3. The left pane of Explorer contains a(n) that lets you see the structure of
your folders.
A. tree
B. icon
C. link
D. menu

4. The icon is at the very top of the tree pane.
A. My Computer
B. My Explorer
C. drive C
D. Desktop

5. All of the following are views you can use to display files and folders except .
A. Thumbnails
B. Rulers
C. Tiles
D. List

PROJECTS

PROJECT 4-1

1. Start Windows if it is not already running.

2. Open My Computer, and then click the Folders button on the toolbar to access the
Windows Explorer Folders bar. 

3. In Windows Explorer, perform the following steps:
A. Change the view to Thumbnails.
B. Change the view to List.
C. Change the view to Icons.

4. If the Address Bar is not visible, select it from the Toolbars submenu of the View menu.
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5. Click the Address Bar drop-down list arrow, and select Recycle Bin.

6. Click the Back button to return to Windows Explorer.

7. Click the icon that represents your computer’s hard disk in the tree pane.

8. Double-click a folder on your computer’s hard disk to view its contents. 

9. Right-click a file or subfolder in the folder to open the shortcut menu. 

10. Select Properties from the shortcut menu to open the Properties dialog box. 

11. Look at the information displayed about the file or folder, and then close the dialog box.

12. Click the Up button on the toolbar until My Computer appears in the Address Bar.

13. Click the Folders button on the toolbar to reopen the resource bar in the left pane.

14. Click the Close button to close My Computer.

PROJECT 4-2

1. Open Windows Explorer, and display the Lesson 4 data folder in the contents pane.

2. Open the Lesson 4 data folder to display its contents with details about the files and folders:
A. Click the Lesson 4 folder, then open the Project4-2 folder.
B. Choose Details from the View menu.
C. Open the Choose Details dialog box and select Name, Size, Type, and Date Modified if

these details are not already selected.

3. Print a copy of the Project4-2 Report Form in the Project Reports folder:
A. Click the Project Report folder to open it.
B. Verify that your printer is accessible and ready.
C. Select the Project4-2 Report Form file, and then select Print from the File menu.

4. Using the Project4-2 Report Form you printed in step 3, do the following:
A. Fill in the heading with the appropriate information.
B. Answer all questions on the Report Form using Windows Explorer to display the sub-

folders and files in the Project4-2 folder.
C. Turn the report in to your instructor if requested.

5. Close Windows Explorer.

6. If instructed to do so, shut down Windows XP and your computer.

TEAMWORK PROJECT

Working with another student, write a list of steps you would follow to use the Windows XP
Search feature to find all the JPEG image files in the My Documents folder. Then use the steps to
conduct the search individually. When you have the search results, select the List or Details view
and click the Name column head to put the list of files in ascending alphabetical order by file-
name (you may need to click the Name column head twice to put them in A to Z order). On a
piece of paper, write the total number of JPEG files you found and the names of the first three
files. Compare your results with your partner’s results. If there are differences in the list, do you
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think they are because you have different files on your computer, or because you set up the
Search criteria differently? 

CRITICALThinking

ACTIVITY 4-1

During lunch, a coworker asked if you thought there were advantages to working with
Windows Explorer rather than My Computer. You told him you would have to think about it
and would give him an answer later in the day. Consider features that might be available in
Explorer but not in My Computer; determine what, if any, operations are easier to perform in
Explorer than in My Computer; and prepare a written response for your coworker.
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